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Welcome to Photobook Designer User Guide.
Photobook Designer is a user-friendly book-making software for Desktop PC or Mac. You 
can easily create photo books with your digital photos and order them through the Internet. 
 
Photobook Designer offers a wide array of tools and features to design and to enhance your 
book project.

Exciting features include:
Upload via PC, Facebook & Flickr  (NEW)
● Switch between different book types 
● New typography tools
● Over 250+ NEW professionally designed
   page layouts, backgrounds, frames, masks,     
   scrapbook templates
● Full customization
● Easy-to-use, streamlined interface
● Enhanced Auto Flow feature
● Improved error-checking feature

Overview

● Automatic software updates
● Convenient ordering process
● Captions - anywhere
● Black & White and sepia filters
● Masking effects
● Enhanced image-editing features
● Unlimited color backgrounds
● Images can cut across page spread
● Flexibility to shape your visuals
● Evenly space items
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PC
● Windows 7, Windows Vista or Windows XP (Service Pack 2 or 3)
● Minimum 768MB of RAM (2GB recommended).
● 2GB hard disk space.
● 16-bit color or better video adapter, 1024x768 or higher screen resolution.
● Broadband Internet connection (DSL/LAN) during ordering process.

MAC
● MAC OS X 10.4.5 or later.
● 2GB hard disk space.
● 16-bit color or better video adapter, 1024x768 or higher screen resolution.
● Minimum 1GB of RAM (2GB recommended).
● Broadband Internet connection (DSL/LAN) during ordering process.

System Requirements

Supported File Types

Installation

AVAILABLE FOR BOTH WINDOWS AND MAC OS

Photobook Designer supports most widely used file types: JPG (JPEG Format), GIF(Graphics
Interchange Format), BMP (Windows Bitmap Format), PNG (Portable Network Graphics), PICT/
PCT (Macintosh PICT), TIFF (Tagged Image File Format).

This section provides instructions on how to install the software on your system.

Installing Photobook Designer
PC
1. Double-click the installation file, Photobook Designer.exe, to launch the installation wizard. 
2. Follow the on-screen installation instructions to install Photobook Designer on your computer.
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Installing a different edition of Photobook Designer
If you’ve already downloaded and installed Country X’s edition of the Photobook Designer
software, and wish to ship to Country Y; you will need to install the Country Y’s edition of 
Photobook Designer.

Scenario 1 
1. Uninstall Country X’s edition of Photobook Designer, then install the Country Y’s edition  
    (from Country Y’s website). 
2. By uninstalling the Country X’s edition Photobook Designer, your photobook file will still   
    remain in the Documents folder. 
3. Open the newly installed Photobook Designer edition (Country Y) and continue working on    
    your book project! 
 
Scenario 2 
If you install Country X’s edition without uninstalling Country Y’s edition, proceed with the following 
steps. 
 
1. Go to the folder location in which Photobook Designer was installed 
    (i.e. C:\Program Files\Photobook Designer).
2. Rename the Country X’s license key to Photobook CountryX.lkey1. 
    (Note: If Country X=Malaysia, your renamed license key should be Photobook Malaysia.lkey1) 
     *See the following screen capture. 
 
3. Open the newly installed Photobook Designer edition. You should now see Country Y’s edition. 

MAC 
1. Double click on Photobook Designer.dmg ; a new window will appear. 
2. Drag the folder ‘Photobook Designer’ into your computer’s Application folder.



Note: You must have administrator user rights to install on Windows 7/8/2000/XP/Vista. 4

Launching Photobook Designer

Upon launching Photobook Designer , a ‘Welcome dialog helper’ will appear where you are 
required to choose either ‘Create a New Project’ or ‘Open an Existing Project’. 

By clicking on ‘Create a New Project’, you are able to see a list of categories of products. Select a 
category and click next. Next, select a product type and click next. You will be able to select from 
a variety of sizes of books in the product selection screen. Choose the product you’d like to create 
and click next or double click on a product to continue. 

Choose some pictures for your project and click next. Name your new book project and click 
Create. To continue from a previously saved project, click on ‘Open an Existing Project’.
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The User Interface
The Photobook Designer’s user interface provides easy access to tools and features you can use 
to edit and make your book. It consists of:

A.  Current Work Page
B.  Page Previews
C.  Toolbar
D.  Picture List
E.  Library
F.  Inspector (Picture Toolbar)
G. Shopping Cart
H. Main Window Menus (Main Toolbar)

Below is a brief summary of the buttons:

Current Work Page
Page Design Area is the large pane in the centre of the software. It displays the content of page, 
i.e. the dimension of artwork and objects.

Pages Previews
The Page Preview pane sits at the top of the window and shows a preview thumbnail for every 
page. Page Previews allows you to see your book progress.
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Pages Previews

Toolbar
The Toolbar is the area between the Page Design and Page Previews areas. It allows easy access 
to some of the common functions within the application. 
 
It contains quick action buttons for the following functions:

Undo - The Undo function allows the last edit to be reversed, up to a maximum of 150 times. 
This allows you to step back if you are not satisfied with the latest changes made to the design. 
 
Redo - The Redo function allows you to step forward through edits. 
 
Save - Allows you to save the current project, during the building/editing of your project. 
 
Add Picture Box - Click to add a new picture box on the current page displayed in the design 
area. Once the box is added, changes can be made using the standard functions on the Inspector.
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Adding Picture Via Facebook- Edit this to “Click on ‘Add Picture from Facebook’ and login to 
your Facebook account. This allows the PB Designer App to retrieve your pictures from Facebook.
 
Note: Facebook automatically reduces your image’s resolution if the ‘high quality’ option is not 
selected. Try to only use images that is uploaded with the ‘high quality’ option enabled.  
 
Adding Picture via Flickr- Click on the ‘Add Photos from Flickr’ and log in to your Flickr account. 
This enables you to select your photos from your Flickr album.  
 
Note: We recommend using images uploaded on to Flickr with the high quality option. 

Autoflow - Autoflow allows the automatic placing of images in available picture boxes, depending 
on either picture order or orientation. See the Autoflow section for more details. 
 
Zoom In and Zoom Out - Use the zoom buttons to quickly zoom in or out of the page design area. 
 
Previous Page and Next Page - Use these buttons to move between pages. Holding down the 
SHIFT key when clicking the buttons will move you to the first and last pages. 
 
Preview option - Use the preview button to get a full screen preview of your project. The preview 
will still show the bleed and gutter areas but will not show empty picture or text boxes. 
(To close the preview and return to the designer, click the Close button.)  

Picture List - The Pictures List sits at the left-hand side of the window and shows thumbnails of 
pictures that are currently loaded within the application.
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Library- The Library pane sits at the bottom of the window and contains Page Styles, Masks, 
Background, Frames and Scrapbook templates.
 
 
A. Page Styles- Page Styles are predesigned templates of empty ‘Picture frames’ on a single 
page. This is where you select predesigned templates to be used on your book cover. You can 
view cover templates when your Current Work Page area displays your cover page. To apply a 
page style, simply drag & drop the desired page layout onto a page. Though it’s applied to a page, 
you still have the flexibility to move the pictures according to your preferred arrangements. Any 
pictures that are currently on the page will be copied into the new page style.  

Page styles are not restricted to the side from which they are saved, so a page style created on 
the left hand page can be placed as normal on the right hand page. However, it is not possible to 
use a cover page style on a page and vice versa. 
 
If the layout has been created on a single page, then you will only have the choice to save the 
layout as a single page style. If the layout has been created on a spread, then you will have the 
choice to save the left page, right page or the entire spread as a page style. It is important that you 
remember this, otherwise you may have to copy your design onto a different page before saving it 
as a page style.

When you add your page style, you will be given the opportunity to enter a name for the style and 
a category. Whilst the name is compulsory, the category is not. Once a category has been entered, 
additional page styles can be added to the category by selecting it from the drop down list in the 
Save As Page Style window. You can also include masking/frame/scrapbook designs to be saved 
as a Page Style. 
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B. Masks- To use the mask templates available in the Library, simply drag your preferred mask 
template from the Library and drop it onto the picture. A mask will always scale to fit the box 
exactly and will never resize proportionally. 

When a mask is added to an item, the background colour of the masked area can be changed 
via the Colour option in the first tab of the Inspector. You can also determine its’ opacity, shadow, 
angle and various function available in this tab. If you wish to remove a mask, you can either drag 
the mask named None on to the item or right-click the item and select the Remove Mask option 
from the context menu. 

C. Background- Backgrounds are pictures that can be added to a page. They could be 
landscapes, patterns or anything else that looks nice as a backdrop across a page.

A background can be added to a page by simply dragging from the library and dropping it onto a 
page. A background will always scale to fit the page proportionally, which means that you can 
double-click on the background and change the crop like a normal picture. If a background is 
dropped in the centre of a spread, then the background will occupy the entire spread.  
 
Alternatively, you may also use your own predesigned background or picture. Load the desired 
image/background template into Picture List. Then, drag and drop the picture onto your desired 
page. Right click on the image and select Fit option from the menu and you will be able to select 
whether to fit the image to one page or as spread (across 2 pages). 
 
When a background is added to a page you can also drop a mask onto it and/or change the 
opacity will allow the page background colour to show through allowing you to create colourization 
effects. 
 
If you wish to remove a background, you can either drag the background named None onto the 
page, or right-click on the page or select the Clear Background option from the context menu.
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Note :  If you intend to use picture as background but still would like to incorporate Page Styles, 
we advise you to insert your desired Page Styles before fitting an image as its background. This is 
to prevent your image from being absorbed into picture frames of this page style. 
 
D. Frames- A frame can be added to pictures to create an ornamental frame around them. Simply 
drag your preferred frame style from the Library and drop it onto an existing picture. Choose from 
a variety of newly-designed frame images from the Library. 
 
If you wish to remove a frame, you can either drag the frame named None onto the picture or 
right-click on the picture and select the Remove Frame option from the context menu.

E. Scrapbook- A scrapbook picture can be added to a page simply by dragging it from the library 
and dropping it onto the page or from the library and into an existing picture box. A scrapbook pic-
ture will behave the exact same way as a normal picture from the picture list, i.e. you can use any 
of the standard functionalities.

Inspector
Modifying an item’s properties

The Inspector pane sits at the right-hand side of the window and contains the controls that allow 
objects to be manipulated. This Inspector allows you to crop, rotate, resize, apply filter effect, fade 
and enhance the picture. The Inspector is split into several tabs that appear above the controls, 
with each tab covering a different category. Each type of item (picture box, text box, shape, etc.) 
has many options that can be changed to alter its appearance. 
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The various options can be accessed via the Inspector 
section on the main window. The controls available in 
the standard Inspector are as follows (from left to right):

A. Item/Shape 
The Item/Shape tab contains the controls that affect the 
basic shape and appearance of an item.

Shape 
The Shape control allows you to change the basic shape 
of the item. If the item is a picture box or shape, then its 
shape can be changed to a square / rectangle, circle / 
oval or polygon. If the item is a text box or a line, then its 
shape cannot be changed.
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-Sides 
If the shape is a polygon, the number of sides, ranging from 3 to 10, can be set either by dragging 
the slider or by inserting the value into the field next to the slider.

- Angle 
If the shape is a polygon, then the angle of the polygon can be set either by clicking and rotating 
the dial control or by inserting an angle value between 0 and 359 
degrees. 
 
- Corner 
If the shape is a square / rectangle, it is possible to round the corners of the item either by dragging 
the slider or by inserting a value between 0 and 100. A higher value will result in a more dramatic 
curve on the squares corners while a lower value will result in a less dramatic curve. 
 
- Colour 
If the item is a text box, line or shape, its colour can be changed by clicking on the control and se-
lecting the required colour from the drop down list. If a colour that is not available in the drop down 
list is required, it is 
possible to choose using the system’s colour picker control by selecting the Other option from the 
drop down menu. If the item is a picture box, then the background colour can be changed if the 
picture box either contains 
a mask or has the Zoom Lock feature switched off. 
More information on these options can be found later 
in this manual.
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- Angle 
If the shape is a polygon, then the angle of the polygon can be set either by clicking and rotating 
the dial control or by inserting an angle value between 0 and 359 
degrees. 
 
- Corner 
If the shape is a square / rectangle, it is possible to round the corners of the item either by dragging 
the slider or by inserting a value between 0 and 100. A higher value will result in a more dramatic 
curve on the squares corners while a lower value will result in a less dramatic curve.

 
 

- Colour 
If the item is a text box, line or shape, its colour can be changed by clicking on the control and 
selecting the required colour from the drop down list. If a colour that is not available in the drop 
down list is required, it is possible to choose using the system’s colour picker control by selecting 
the Other option from the drop down menu. If the item is a picture box, then the background colour 
can be changed if the picture box either contains a mask or has the Zoom Lock feature switched 
off. More information on these options can be found later in this manual.
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Border / Line
Depending on the selection, this section of the Inspector will allow you to define the style of a line 
or a shape’s border. Enabling this will give the picture box, text box or shape an outline to add 
definition. To enable for a picture box, text box or shape, select the item and check the box next to 
border.

- Size
The size of the border or thickness of a line can range from 1 to 40, with 40 being the thickest 
border.

- Colour 
To change the colour of the border or line, click on the control and select the required colour from 
the drop down list. If you require a colour that is not available in the drop down list, it is possible to 
choose the colour using the system’s colour picker control by selecting the Other… option from the 
drop down menu. 
 
- Opacity 
The Opacity can range from 10 to 100, with 100 being solid.

Drop Shadow 
This enables a drop shadow effect on the item. The options below allow you to dictate how this 
appears: 
 
- Offset 
The Offset is essentially how far away from the item you wish the drop shadow to appear. This 
value can range from 0 to 200 and can be controlled by dragging the slider or inserting the value 
into the field next to the slider. 
 
- Angle 
The Angle control defines the direction of the drop shadow. For example, a value of 180 would cast 
the shadow directly below the item. The angle can be entered either by rotating the dial control or 
by inputting a value between 0 and 359 into the field. 
 
- Blur 
The Blur option controls how blurred the drop shadow will be. A value of 0 will define a sharp 
(non-blurred) shadow, whereas the maximum value of 8 will define a very blurred / hazy shadow. 
 
- Colour 
The Colour control allows the colour of the drop shadow to be changed. The drop shadow colour 
can be changed to either one of the standard colours or a custom colour via the Other… option 
within the drop down list.
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B. Picture Tab
The Picture tab on the Inspector allows you to 
manipulate the picture within a picture box. From here, 
you can define the orientation, colour mode and apply 
a vignette. These options apply to the box, not the 
picture currently within the box. This means that if you 
set a picture box’s colour mode to be Sepia, any picture 
placed into that picture box will be displayed in Sepia. 
This does not affect the actual picture file itself though, 
only its’ usage within Photobook Designer.

Orientation
The Orientation section of the tab allows the orientation 
of the picture within the picture box to be controlled.

- Angle 
The Angle control allows the basic angle of the picture to 
be controlled. The angle selected from the drop down list 
and can either be 0, 90, 180 or 270 degrees. 
 
- Flip Vertical 
The picture can be flipped vertically within the picture box 
by checking this checkbox. 
 
- Flip Horizontal 
The picture can be flipped horizontally within the picture 
box by checking this checkbox.

Colour 
The Colour section of the tab allows you to change the 
colour settings for the picture. 
 
- Mode 
Photobook Designer supports three colour modes: 
Original, Sepia and Black and White (de-saturate). 
Choosing Sepia or Black and White will change the 
appearance of the picture within the picture box, while 
choosing Original will return the picture to its original 
colour.
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- Brightness 
The brightness of the picture within the picture box can be controlled using the slider or by 
inserting the required value into the field to the right of the slider. Values which are lower than 0 will 
make the picture darker while values higher than 0 will make the picture lighter. A value of 0 will 
return the picture to its original brightness. 
 
- Contrast 
The contrast level of the picture within the picture box can be controlled using the slider or by 
inserting the required value into the field to the right of the slider. Values which are lower than 0 
will reduce the amount of contrast while values higher than 0 will increase the amount of contrast. 
A value of 0 will return the picture to its original contrast setting. 
 
Vignette 
A vignette can be applied to the picture by checking this checkbox. The vignette has several 
different options available: 
 
- Shape 
The shape of the vignette. This can be set to either square / rectangle or circle / oval by selecting 
the required option from the drop down list. 
 
- Size 
The size of the vignette border. This value can be in the range of 0 to 40, with 40 being the thickest 
border and 0 being no border.

- Blur 
The level of blurring at the edge of the vignette. A value of 0 will define a sharp (non-blurred) edge, 
whereasthe maximum value of 8 will define a very blurred / hazy edge. 
 
- Colour 
The colour of the vignette. This is selected from the drop down list or by clicking Other... to select 
from the system colour picker. A value of None here will make the vignette transparent, allowing 
you to blend the edges of the picture into the page background.
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C. Text Tab 
The Text tab on the Inspector allows you to manipulate the text within a text box.



Note: You must have administrator user rights to install on Windows 7/8/2000/XP/Vista. 18

- Font 
The Font control allows you to select from a range of fonts, select font size and manipulation of 
font orientation. The options are: Colour, Opacity, Width, Skew X and Skew Y which will allow 
users to edit the font’s colour, increase or decrease the opacity of the font, increase or decrease 
font’s width and skew the fonts horizontally and vertically. 

- Outline 
The Outline control allows you to outline your fonts and you will also be able to select the outline’s 
colour.

- Spacing 
The Spacing control allows you to specify how much space there is between the edge of the text 
and the text within it. The options are: margin size, character, paragraph and baseline. This can be 
useful if you have applied a border to the text box and you do not want to have a gap between the 
border and the text. 
  
- Alignment 
The Alignment control allows you to select the vertical alignment of the text within the text box. The 
options are: Top, Centre, Bottom, left, right and justified. These options can also be selected from 
the drop down list.

- Paragraph 
The Paragraph control allows you to specify how much space there is between each line of text 
within the text box. This can be useful if the text box is a fixed size and you want to prevent a large 
empty space at the end of the text. Text lines can be spaced apart by increasing the paragraph 
value and can be merged together by decreasing the value.
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D. Measurements Tab 
The Measurements tab on the Inspector allows you to manipulate the position and size of an item 
instead of dragging it.
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- Position 
The position section can be used to set the exact X and Y co-ordinates of an item on the page. 
The coordinates will be displayed in either millimetres or inches, depending on the setting within 
the application preferences. The Ruler Origin, which is at the position 0, 0, can also be set within 
the application preferences. 
 
- Size 
The size section can be used to set the exact height and width of an item on the page. 
The co-ordinates will be displayed in either millimetres or inches depending on the setting within 
the application preferences. 
 
- Constrain Proportions & Offset 
The Constrain Proportions option controls how objects are resized. If this option is checked, then 
the item will always be resized proportionally to its original size. This is useful for picture boxes 
as it means that the entire picture will always be visible. If this is unchecked, then the size can be 
resized freely. This option is enabled by default for new items, but can be changed within the 
application preferences. If the height or width of a picture box, text box or shape is changed by 
typing the new size into the Inspector, the application will now scale the other dimension 
proportionally if the Constrain Proportions checkbox is checked for the item. If the other 
dimension is out of bounds, the item’s size will revert to its original size.

- Offset 
The offset section defines the vertical and horizontal position of the picture within the picture box. 
When a picture is cropped, panned or zoomed these settings are set automatically. However, it is 
possible to set them manually if required. Panning a picture can be performed manually by holding 
down the Alt key while dragging the picture within the picture box as well as within the 
Crop Picture window.

- Scale 
The scale value controls the magnification of the picture within the picture box. When a picture 
is cropped or zoomed this value is set automatically. However, it is possible to set it manually if 
required. Zooming a picture can be performed manually by holding down the Control and Alt key 
while dragging the picture within the picture box as well as within the Crop Picture window.
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- Zoom Lock 
The Zoom Lock option is an advanced option that controls if a picture can be dragged outside the 
bounds of the picture box. The default for all picture boxes is for this option to be enabled, in which 
the edges of the picture will always touch the edges of the picture box. If this option is unchecked, 
the picture can be scaled or moved freely within the picture box using the key combinations of Alt 
for panning and Control + Alt for zooming. 
 
- Angle 
This option allows you precise control over the rotation of the picture box on the page. The value 
can be changed by dragging the dial control or by inputting a value between 0 and 359 into the 
field to the right. Currently, text boxes can only be rotated to 0, 90, 180 or 270 degrees.

E. Page Background Tab 
The Page Background tab on the Inspector allows you to change the background colour of the 
pages. This tab will show a different number of controls depending on the product configuration 
and the current page.

Shopping Cart

Click on the shopping cart to start the order process. See the Ordering section for further details on 
how to order a book.
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Main Window Menus

Check Product - This will conduct a pre-flight check on the product. The pre-flight check will warn 
you of a variety of issues that could affect the output of the product, as listed below. This check will 
also be performed prior to ordering in Photobook Designer.

File Menu Options 
Save - Save the current state of the product or project.
 
Close - Close the current product or project
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Create Proofs - Before ordering, it is a good idea to check the project and create proofs of the 
project. This will ensure that the project is printed as expected. To check the project, go to the file 
menu and select Check Project.
 
Order - Submit order by uploading your book via online shopping cart. 
Preferences - Set your preferred options for project measurements, constrain proportions, and 
auto updates.

Insert Menu options 
To add objects onto the page, we can either use the Insert menu or a keyboard shortcut. The 
keyboard shortcuts are as follows: 
 
Insert Picture Box – Control + Shift + B 
Insert Picture Oval – Control + Shift + O 
Insert Text Frame  – Control + Shift + T

Picture Box → Rectangle 
Picture Box → Oval 
Picture Box → Polygon 
Shape → Square 
Shape → Circle 
Shape → Polygon 
Shape → Line 
Text Box 
 
Page Menu options 
The page menu allows you to manage the pages within your project. The available options are as 
following: 
 
- Insert 
This allows empty, new pages and / or spreads to be inserted at the currently visible point in the 
album. This may not be available if the page limit of the product has been reached. 
 
- Duplicate 
Duplicates the currently selected page or spread. This may not be available if the page limit of the 
product has been reached. 
 
- Add 
This adds an empty, new page at the end of the album. This may not be available if the page limit 
of the product has been reached. This option will either add a single page or a spread. 
 
- Delete 
This will delete the currently selected page or spread from the album. This is irreversible, so take 
caution when using this option. Please ensure your book’s page number reaches our minimum 
page limit after deleting pages.
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- Rearrange Pages 
From this option, you can rearrange the pages or spreads within your album. It is important to note 
that this action cannot be undone except by rearranging the pages manually back to their original 
order using this option again. 
 
- First, Last, Next, Previous 
These options will jump to the first page in the album, the last page in the album, the next page 
after the selected and the previous page before the selected.

View menu options 
From here, you can change the way Photobook Designer is presented to you. You can choose 
to Hide Inspector, Hide Library, Hide Page Previews, or Hide Pictures. Here, you can choose to 
enable or disable the display of the respective components of the Photobook Designer main 
window. You can disable these to maximize the viewable area on screen of the pages, or if they 
are not required during the creation of your project.

Show Rulers 
This option turns on the rulers and shows them around the page. You can also click and drag from 
the ruler onto the canvas to be given guidelines. 
 
Guide 
Control the display and settings for guides. 
 
- Show/Hide Guide 
Show Guides. Once this is selected, the menu item will change to Hide Guides (and vice versa). 
 
- Snap Position 
Items being moved in the page design area will move to the guide position as the approach the 
guide. You will need to move the cursor away from the guide before the select item then moves 
again. Checked when active. 
 
- Clear Page Guides 
Clears all (User Guides) Guides on the current page displayed. 
 
- Clear All Guides 
Clears all the guides within the product or project. 
 
- Guides Settings 
Sets the display colour for Master and User Guides. 
 
Grids 
Grid Control the display and settings for the grid. 
 
- Hide 
Hide the grid. Checked when active
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- Show 
Show the grid. Checked when active. 
 
- Show When Dragging 
Only show the grid when moving picture or text boxes around in the page display area. 
 
- Snap Position 
The object selected is pulled to the grid lines once released. Checked when active. 
 
- Snap Position to Page Items 
Objects snap to vertical/horizontal alignment of other page items when dragged around the page. 
Checked when active. 
 
- Grid Settings 
Here, you can set the colour of the grid and the size of the grid lines. In addition, the number of sub 
divisions per grid box can also be set.

Minimum Zoom, Zoom Out, Zoom In, Maximum Zoom 
These options allow you to control how large the pages are displayed in the main window. To 
get an overview of the page, select minimum zoom. To zoom in as close as possible, select 
maximum zoom. When it is zoomed in at maximum, you can right click on an image in a picture 
box and select Show High Quality Picture. This will display the high resolution image within 
Photobook Designer, as opposed to a compressed version which is displayed as standard for 
performance reasons. 
 
Hide Non-Printable Items / Show Non-Printable Item 
Allows items that have been set to Non-Printable to be hidden from the page design area. Once 
selected, the option changes to Show Non-Printable items. If selected, then the Non-Printable 
items will be displayed on the page. 
 
Show Box Guides / Hide Box Guides 
To turn off the guides around each object on the page, select Hide Box Guides. To enable them 
again, select Show Box Guides. This option is only available to administrators. Non-printable items 
have a light blue border when selected to show that they are non-printable. This border does not 
appear to the end user.

Preview 
Use preview button to get a full screen preview of your project. The preview will still show the bleed 
and gutter areas but will not show empty picture or text boxes.
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Creating Your Photo Book

A.Working with Pictures

i. Adding Pictures
To populate the Pictures list, simply click the ‘+’ button.

A window will open, asking you to select the folder that contains your pictures. Select the folder 
and click the OK button. This will then scan the folder, create thumbnails of the pictures and then 
display them in the Pictures pane. The original images are not affected during this process. The 
width of the Picture Library can also be expanded by either double clicking on the edge of the 
library, or by dragging it to your desired width.
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ii. Adding pictures onto page
To add a picture to the page, you can either drag and drop it directly onto the page at the required 
location or drag and drop it into an existing picture box. When the picture can be dropped, a blue 
outline will appear, highlighting where the picture will be dropped.

When an image is placed on the page, it will retain its original proportions and be displayed in its 
entirety.If an image is dragged into an image frame, the image will be scaled to fit the frame and 
could be cropped. Photobook Designer will intelligently judge the size of the image in comparison 
to the image frame to determine the best scaling. 
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When a picture from the Pictures List has been used, a red circle with a number appears over the 
thumbnail, while the number of how many times an image has been used will appear in the centre 
of the circle. This will help you to determine which images have and have not been used.

You can track where your pictures have been used by right-clicking on the thumbnail, and selecting 
Picture Usage from the context menu.
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- Cropping pictures
A picture can be cropped by moving the cursor to the picture, and then double-clicking on the 
picture.
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When the Crop Picture... window is displayed, you can manipulate the area of the picture that is 
to be displayed. Be careful not to make the visible area too small, else the resolution of the image 
could be too low for a quality print. You can also manipulate the cropping and zooming of an image 
directly from the page layout by dragging the picture whilst holding Control and Alt to zoom and Alt 
by itself to pan.

iii. Managing Pictures

- Categorizing Pictures
Pictures within the library can be categorised into groups by clicking the picture settings icon and 
selecting Categorise from the drop down menu. 
 
Pictures can be categorised by:
● Folder Name
● Date Created
● Date Modified
● Picture Orientation
● Picture Usage

Once pictures have been categorised, a heading is placed above each category within the library. 
Clicking on the heading expands/collapses each category. Clicking the Cross icon closes the 
category. 

- Sorting Pictures
Pictures can be sorted within the library, whether they are categorized or not. This can be done by 
selecting the settings icon and Sort from the drop down menu. 
 
Pictures can be sorted by:
● Filename
● Date Created
● Date Modified
● Picture Orientation
● Picture Usage
● Rating

Pictures can also be sorted in Ascending or Descending order.
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- Rating Pictures
You can give a rating to the pictures by right-clicking on a picture within the library and selecting
My Rating from the context menu. Pictures are rated by stars, five stars being the highest rating.

If the pictures in the library have been given ratings, you can determine whether or not to show the 
rating below each picture. To turn this feature on or off, click the Settings icon and from the drop 
down menu and toggle the Show My Rating on or off. 
Pictures can also be sorted by their rating as described earlier.

- Changing a picture’s orientation
If a picture’s orientation is not correct, it can be changed by right-clicking on its thumbnail and 
selecting the required angle from the Rotate sub-section in the context menu. 
 
If an individual picture needs to be removed from the list, it can be done by right-clicking on 
its thumbnail and selecting the Remove Picture option from the context menu. To remove all 
thumbnails from the list, click the Clear Picture List option from the Settings menu.

- Locating a picture on the disk
To locate where a picture is located on a disk, either right-click on its thumbnail in the Pictures List 
or right-click on the picture on the page and select the Show in Finder / Show in Windows Explorer 
option.
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B.Working with Objects & Layouts

i. Adding new items onto page

As well as adding empty text boxes to a page, it is also possible to add empty picture boxes and 
various shapes by selecting the required option from the Insert menu or by using one of the 
following keyboard accelerator keys:

● Rectangle Picture Box Command / Control + Shift + B
● Oval Picture Box Command / Control + Shift + O
● Text Box Command / Control + Shift + T

ii. Selecting items on the page

To select an item on the page, you can simply position the cursor over the item and click the left 
mouse button. This will automatically de-select any other selected items. If you wish to select 
multiple items, you can hold down the SHIFT key before clicking the left mouse button. 
To de-select an item that has already been selected, hold down the SHIFT key and then click the 
left mouse button. To quickly select all items on the page select the Select All option from the 
Edit menu.

iii. Moving items on the page

When you have placed items onto the page, you may wish to move item from their current 
position. To do so, simply select the item and then drag it around the page until you are happy with 
its position. If you hold down the SHIFT key before dragging the items, the move will be locked in 
the direction that you first move the items. You can also move items via the cursor keys holding the 
SHIFT key down to move in larger steps.

iv. Resizing items

To resize an item on the page, you must first select it and then click on one of the grab handles that 
surround it. At this point, you can simply drag to change the size of the item. If you are resizing a 
picture, the scaling and cropping of the picture will change depending on the picture box size. 
By default, items will be resized proportionally but this can be changed per item by undoing the 
Constrain Proportions check box option within the Inspector. The default constrain proportions 
setting for new items can be set via the application preferences accessible from the File menu. If 
you are resizing a text box, the text will be reflowed automatically to take into account the new text 
box size. If the text overflows the box, the text box will turn red and display a small marker in the 
corner. This will also be detected during pre-flighting of the product.
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v. Fitting items to the page

To quickly resize an item on the page so that it fits the entire page or spread you must first select it, 
right-click and then select one of the options from the Fit context menu.

- Fit To Page
This option will resize the item so that it fills the entire page it is located on.

- Fit To Spread
This option will resize the item so that it fills the entire spread it is located on.

- Fit Picture To Box
This option will change the picture’s crop so that it will best-fit the picture box.

- Fit Box To Picture
This option will change the size of the picture box so that it will best-fit the picture.

TIPS: When positioning your pictures, avoid placing important objects (eg. faces, text boxes, etc) 
directly on the center of the spread (along the binding strip). As our books are binded using PUR 
glue for the most durable binding strength, pictures that spread across the center line may seem 
curved or certain parts may be hidden from view.
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vi. Aligning items to the page

Photobook Designer allows items to be aligned by right-clicking on an item and selecting the 
required option from the Align context menu. You may select more than one item by holding onto 
the Shift key and click on your selections.

- Align Top
This option is available when more than one item is selected and allows the top edges to be 
aligned. If any of the items contain a border, then the alignment will not take into account the 
border when determining the top-most edge.

- Align Left
This option is available when more than one item is selected and allows the left edges to be 
aligned. If any of the items contain a border, then the alignment will not take into account the 
border when determining the left-most edge.

- Align Bottom
This option is available when more than one item is selected and allows the bottom edges to be 
aligned. If any of the items contain a border, then the alignment will not take into account the 
border when any of the items contain a border, then the alignment will not take into account the 
border when determining the bottom-most edge.

- Align Right
This option is available when more than one item is selected and allows the right edges to be 
aligned. If any of the items contain a border then the alignment will not take into account the border 
when determining the right-most edge.

- Align Vertical Page Centre
This option centres the selected item(s) vertically on the page.

- Align Horizontal Page Centre
This option centres the selected item(s) horizontally on the page.

- Align Horizontal Spread Centre
If the product is a spread, this option centres the selected items(s) horizontally across the spread.
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vii. Arranging Item on the page

Photobook Designer allows items to be aligned by right-clicking on an item and selecting the 
required option from the Align context menu. You may select more than one item by holding onto 
the Shift key and click on your selections.

- Send To Back
This sends the selected item to the back of the page and behind any other items that it may 
currently be on top of. The item will always remain above any background that may have been 
assigned to the page.

- Send Backwards
This sends the selected item further back in the z-order. You can use this option to step the item 
backwards, ordering the items in the desired manner. The item will always remain above any 
background that may have been assigned to the page.

- Bring To Front
This brings the selected item to the front, placing it on top of any items that it may be behind.

- Bring Forward
This brings the selected item forward one step in the z-order. You can use this option to order the 
items in the desired manner.

viii. Arranging Item on the page

To help preventing items from being moved accidentally, it is possible to lock them. Locking an 
item can be achieved by simply right-clicking the item on the page and selecting the Lock option 
from the context menu. Unlocking an item can be achieved by simply right-clicking the item on the 
page and selecting the Unlock option from the context menu. 

- Space Items
To evenly space items on a page, select the items to be 
spaced, right click and select the Space Items option from 
the Align/Space menu. The option allows you to specify 
the horizontal and vertical space between items, or from 
the left edge, centre or right edge of the first item. 
 
To choose the distance between items on a page, choose 
the Space Items from the context menu and enter the 
measurements between items.
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When multiple items are selected, it is possible to group them together as one item. This prevents 
items from being moved independently if they should always be kept together. Grouping items can 
be achieved from being moved independently if they should always be kept together. Grouping 
items can be achieved by simply selecting the items on the page, right-clicking and selecting the 
Group option from the context menu. Ungrouping items can be achieved by simply right-clicking 
the items on the page and selecting the Ungroup option from the context menu.

C. Working with Text

i. Adding textboxes onto page
To add a text box, simply select Text Box from the Insert menu or press Command / 
Control + Shift + T. When the new empty text box appears on the page, you can modify its contents 
by double-clicking on it.
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The Edit Text… window allows you to 
type the text that you wish to appear 
inside the text box.
 
To change the text properties such as the 
font, size, style and colour, simply select 
the text and choose your new settings. 
The application will automatically change 
the background colour of the text edit 
area if the text is a light colour. 
 
To change the line / paragraph 
justification, simply select the line and 
click the relevant alignment button. To 
copy or paste items in the text editor, 
right-click in the editor and select the 
option from the context menu. 
 
If the text is out of bounds for the size 
of text box chosen – either due to size of 
the text of the amount, then in the page 
design area, the text box will be outlined 
in red when selected and have red error 
sign inside the textbox when not 
selected.

Additionally, when the product is flight-checked, in the warnings box, there will be a red error sign 
with Text Overflow Box as the issue.
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When multiple items are selected, it is possible to group them together as one item. This prevents 
items from being moved independently if they should always be kept together. Grouping items can 
be achieved from being moved independently if they should always be kept together. Grouping 
items can be achieved by simply selecting the items on the page, right-clicking and selecting the 
Group option from the context menu. Ungrouping items can be achieved by simply right-clicking 
the items on the page and selecting the Ungroup option from the context menu.

C. Working with Text

i. Adding textboxes onto page
To add a text box, simply select Text Box from the Insert menu or press Command / 
Control + Shift + T. When the new empty text box appears on the page, you can modify its contents 
by double-clicking on it.

Photobook Designer will place every picture in the available picture boxes and will automatically 
create additional picture boxes where necessary. When Auto Flow processes each page, it flows 
from top left to bottom right. Photobook Designer will look at each unused picture in the picture list 
and determine if it is landscape or portrait. It will then match landscape pictures to landscape boxes 
and portrait pictures to portrait boxes. After that, it will just use the other unused pictures in the 
pictures list.

Auto Update
Every time there are any new updates available, you will receive first-hand notice the moment you 
open Photobook Designer. If auto update has been selected and updates are available, you will be 
asked if you wish to download the updates. The software will then automatically start the update 
process. You may need to restart your computer for the updates to take effect - the Help box on 
your screen will tell you.
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Changing Product Type

Photobook Designer Software also allows you to change your product size in the middle of your 
project. You may change your product size and type from Imagewrap to Debossed and vice versa. 
Besides that, you will also be able to change the photobook’s size and orientation of your 
photobook. Please be advised that product changes may cause layout changes/error in the layout. 

Placing Order

Uploading your book
Once your project is finished and you are happy with the proofs, the project can be ordered from 
Photobook Worldwide. To do this, you can click on the Shopping Cart icon on the tool bar or select 
Order from the File menu.

IMPORTANT:We do NOT accept any amendments or changes to be made to the file ONCE the file 
is uploaded. Therefore, it is the customer’s responsibility to check the proofs thoroughly before 
uploading their book for processing.
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Flight check
The software will run the flight check to show any areas that might be a problem and displays the 
results.

If the flight check only shows yellow error icons, you can cancel the order and return to the project 
to fix the problems or click OK to continue. If there are issues that remain unresolved, a window 
appears to ask if you wish to continue.

However, if the flight check displays red error icons, the order cannot be placed until the problem is 
resolved.
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Red error message circumstances:

● Missing Pictures – Can occur if a picture’s location has moved, or the picture has became in
   compatible or if the picture has been edited outside of Photobook Designer in such a way that its
   dimensions have changed.
● Overflowing Text
● Missing Font
● Missing Mask
● Missing Application
● Missing Product Scrapbook Picture / Background
● Missing Product Mask

Yellow error message circumstances:

● Empty Picture Box
● Empty Page
● Empty Text Box
● Low Quality Picture
● Low Quality Background Picture
● Low Quality Background Mask
● Low Quality Picture Mask
● Low Quality Shape Mask

To solve the problem, you can right-click the picture box and select the Update Picture Box option 
from the context menu. Alternatively, a different picture can be dropped into the picture box. 
 
Once you are happy to continue, you can follow the instructions and reach the order disclaimer. 
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Ordering Process
You must accept the disclaimer before you are able to start ordering. You will require Internet 
access to start the order process. Once you click on Start, the window below appears.

Once this window appears, a browser window will launch and you will be directed to Photobook 
Worldwide’s online order page.
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If you already have a username and password, then enter them here. If you do not have a 
username and password, then you will need to create a new account. Do this by clicking on the 
“Create an account” button. This then takes you to the new account page, shown below.

Choose a login name and password, and fill in the rest of the details. Remember to select your 
Communication Preferences. Once you have successfully completed your details, click Create.
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Once you have logged in, the order details page is displayed. Here, you can enter the quantity 
require and choose the paper option and cover type to be used (if Photobook allows you to choose 
these items.
 
On the next page, you will confirm the shipping address, billing address and the shipping method 
you wish to use. To change the shipping address, click on Change and a new window opens so 
that you can change the address details. If the billing address is different from the shipping 
address, then uncheck the “Same as Shipping Address” option and click the Change button to 
modify the address in the new window.

The shipping methods that are available to you are shown along with their respective price. 
Choose the method you wish to use.

Payment
On the payment page, the final cost of the product will be displayed in the cart summary, along with 
the payment methods available. Choose which payment method you prefer, and confirm the order. 
Once your order is accepted, the order confirmation screen is displayed, along with your order 
number. 
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This is also the page where you enter your voucher code (if you are using any discount/
promotional code or gift certificate). Click Redeem after you’ve entered the code. The system will 
automatically deduct any discounted amount based on the voucher code inserted. 
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The order is not complete until the project has been uploaded. The software recognizes that the 
order has been accepted and will now show the options of uploading the project to Photobook 
Worldwide. 

Upload finished pages
The completed project is encrypted and uploaded directly to Photobook Worldwide’s server.

Save Finished pages
The completed project is encrypted and saved locally so that they can be mailed to Photobook 
Worldwide. 
 
Clicking on the Test button will allow the software to check the page sizes and the internet speed 
to give you an indication of how long it will take to upload the project. The times are displayed next 
to the relevant options that are available. 
 
Click Continue to upload the pages. If you click the Cancel button, a prompt window will appear 
asking you to complete the order now, or complete later. If you select Complete Now, the software 
will continue to upload the order as normal. If you select Complete Later, you will be able to return 
to the software later, and continue to complete your order on your next return.

A new window displays the progress of the upload. Once the upload has completed, click Finish 
to return to the application. If you choose to save the files, then you will be asked to choose the 
location.

Click Continue to save the files and return to the application. You will need to send the files to 
Photobook Worldwide for your project to be printed.

Contacting Us
Technical Support & Feedback
For any technical support issues or feedback, please use our Online Support Form. Alternatively, 
you can also send an email to support@photobookworldwide.com. 
 
IMPORTANT: To make sure that Photobook’s emails aren’t filtered into your “junk” filter, please add 
our email to your ‘contact’ or ‘list of trusted senders’.

Updates & Promotions
To find out about the latest news of our products, please visit www.photobookworldwide.com. 


